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ABOUT THIS BOOKLET 

 

This booklet provides a series of format guidelines aimed to help you in your 

assessments. Remember, however, that this resource is no substitute for the primary 

source itself. That is: 
 

APA (7th Edition), Publication Manual of the American Psychological Association. 
 

There are a number of copies in the Central library (call no. Z253.A38 2020). 
 

General APA 7th formatting guidelines can also be found online at: 

https://owl.purdue.edu/owl/research_and_citation/apa_style/apa_style_introduction.ht

ml  

 
DISCLAIMER 

 

This booklet provides advice as to the formatting requirements relevant to the 

PSYC3010 Assessments. As such, there are many topics to which this booklet does 

not speak (e.g., referencing in APA 7). Again, the reader is directed to the primary 

source for guidelines on the formatting of these other areas. 

https://owl.purdue.edu/owl/research_and_citation/apa_style/apa_style_introduction.html
https://owl.purdue.edu/owl/research_and_citation/apa_style/apa_style_introduction.html
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BASIC FORMAT STYLE GUIDELINES FOR ASSESSMENTS 
 

• Double-space all text, including title page, headings, figure/table titles and 

notes, and references. 

• Use correct APA format headings (see next page). 

• While fonts have been made more flexible for APA 7 (vs. APA 6), it is 

preferred that students use 12-point Times New Roman or 11-point Arial font 

throughout the document. 

• Use indentations of half an inch or one tab (5-7 spaces) to begin new 

paragraphs. 

• Use margins of one inch (i.e., 2.54cm) at the top, bottom, left and right of the 

document. 

• Align all in-body text to the left. Keep the right side of the text “jagged”. That 

is, do not “justify” the text to stretch it evenly across the line. 

• The title should be fully explanatory when standing alone. It should be a 

concise statement of the main topic, identify the variables or theoretical issues 

under investigation, and the relationship(s) between them. 

• A running head is not technically required for student papers. However, we 

prefer students to adopt a professional style which includes a running head. 

This is an abbreviated version of the title and should be no more than 50 

characters (including spaces and punctuation). It must be positioned flush left, 

and appear in all uppercase letters at the top of the title page and all 

subsequent pages. 

• Page numbers must be presented in the header aligned flush right, and be in 

the same font as the rest of the text (e.g., 12-point Times New Roman or 11-

point Arial). 

• Do not put an additional line space between headings and/or subheadings and 

the subsequent text. 

• Likewise, do not place a line space between paragraphs. 

• Do not start new sections on a new page (unless it is the Introduction 

following the Abstract or the References section following the Discussion). 

• Do not leave widows (where the majority of a paragraph appears on one page 

with the last line flowing onto the top of the following page) or orphans 

(where the first line of a paragraph appears on its own at the bottom of a page 

and the remaining portion appears on the following page). 

• One space is to appear after a full stop at the end of a sentence. 

• Table and figure formatting both require a title/caption at the top. 

• Examples (e.g., example items from a scale) are to be presented in quotation 

marks rather than italics. However, anchors of scales or responses to scale-like 

questions are to be presented in italics rather than quotation marks. 

• Define all known abbreviations/acronyms used within the text the first time 

they are presented e.g., ANOVA, SMR, HMR, MMR. However, do not 

invent/create acronyms, as this interferes with the clarity of your writing. 
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• Use inclusive and bias-free language. This includes the use of the pronoun 

“they” rather than “he” or “she”, and employing labels that are sensitive to 

how social groups and people describe themselves. 

• Use language with an appropriate level of specificity rather than relying on 

broad categories (e.g., people aged 50 to 65 years rather than over-50s). 

• While APA 7 states that reporting of values is to be determined by the 

precision of measurement, it is generally advised that means and standard 

deviations for integer scales are rounded and presented to one decimal place. 

• Correlations, proportions and inferential statistics (e.g., t, F) are to be rounded 

and presented to two decimal places. 

• Exact p-values are to be reported. While APA 7 allows for this to be to 2 or 3 

decimals, since any p-value less than .001 must be reported as p < .001, it is 

preferred that students report all p-values to 3 decimal places for consistency. 

• A zero should be placed before a decimal if the number is less than one, but 

the value can potentially exceed ±1, e.g., F(3, 56) = 0.67, SD = 0.3. However, 

if the value cannot potentially exceed ±1, no zero should appear before the 

decimal point, e.g., r(38) = .23, p = .062. 

• Effect sizes and confidence intervals are to be supplied wherever possible for 

point estimates/statistics. 

• Numbers at the start of a sentence are to be spelled out in words. Likewise, 

common fractions should appear as words rather than numerals (e.g., one 

third). 

• Numbers below 10 are to be spelled out in the text in words. Anything higher 

should appear as a numeral. 

• When representing a point on a scale, an age, a place in a series or after a 

noun, numerals should be used (e.g., three 2-year-olds, Item 4, a 7-point Likert 

rating scale). 

• English/Latin lettered statistical notation should appear in italics (e.g., t, F, r), 

while standard notation should be applied for Greek letters (e.g., η, ω, β). 

However, notation presented as subscripts or superscripts should appear as 

standard type. 

• Spaces should appear between elements of statistical notation e.g., F(3, 32) = 

6.32, p = .002, η2
P = .37. 

 

 

An applied example of this formatting is provided on the following page. 
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EXAMPLE OF BASIC APA 7 FORMAT 

Title of Assessment is Centered, in Boldface Type, with Upper and Lowercase Letters 

for Each Word, Contains No Abbreviations and Can Take One or Two Lines 

We then go straight into the text for the Introduction. Notice that there is no 

“Introduction” heading, just the actual title for the paper. The Introduction is the only 

exception regarding this, as all other sections have an appropriate explicit (sub)heading e.g., 

Method, Results, Discussion and References. One of the key changes between APA 6 and 7 

is that only one space should appear after a full stop, where previously it had been two. 

Note that the first line of each paragraph is indented. This should be a half-inch or 

one tab (5-7 space) indentation. It is important that you make use of paragraphs, as to write 

in one huge chunk is not acceptable. Also observe that all margins on the page (i.e., top, 

bottom, left and right) should be one inch (i.e., 2.54cm) and all text is double-spaced. 

Level 1 Heading (e.g., Method) is Centered and in Bold 

Level 2 Heading (e.g., Materials) is Aligned Flush to the Left and in Bold 

Level 3 Heading (e.g., Depression Measure) is Left-Aligned, Bold and Italicised 

The body of the text following a Level 1, Level 2 or Level 3 heading should begin on 

a new line and be indented. The text should be either 12-point Times New Roman or 11-

point Arial font, though we prefer the former rather than the latter. Again, everything should 

be double-spaced, with “0pt” selected under “Paragraph” → “Indents and Spacing” → 

“Spacing” → “Before” and “After” to prevent additional and unwanted spacing being added 

between lines. The text should also be aligned flush to the left, with jagged edges to the right 

(that is, do not “justify” the text). Do not leave “widows” or “orphans”, where a single line 

of text from a paragraph is left either at the top or bottom of a page, respectively. 

Heading Level 1 (e.g., Results) 

Note that when you begin a new section (e.g., going from the Method to Results), 

you do not start a new page. Instead, when you begin a new section, you just press ‘Enter’ 
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on the keyboard once on the previous line. Do not leave an extra line between sections or 

subsections. To help with this, select “Don’t add space between paragraphs of the same 

style” under “Page Layout” → “Paragraph” → “Indents and Spacing” → “Spacing”, to 

prevent Microsoft Word automatically spacing without your consent. 
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BASIC WRITING STYLE FOR ASSESSMENTS 

DO… DO NOT… 

• Use first-person perspective (e.g., “I”, 

“our”). 

• Employ the gender-neutral pronoun 

“they” to avoid use of gendered 

pronouns where necessary. 

• Apply labels that are sensitive to how 

individuals and groups within society 

view themselves (e.g., people living in 

poverty vs. poor people). 

• Organise your ideas into paragraphs, 

and write in complete sentences. 

• Ensure paragraphs are 3-5 sentences 

long (one idea = one paragraph). 

• Use transitions to relate one idea to the 

next, especially between paragraphs. 

• Use simple, concise, formal and 

academic language. 

• Make clear, direct statements using the 

active voice (e.g., “The human 

resources manager distributed the forms 

to the hospital employees.”) 

• Spell out each word. When using 

established acronyms, write them out in 

full the first time you use them. This 

includes defining abbreviations such as 

ANOVA, SMR, HMR and MMR. 

• Include a title page that conforms to 

APA 7th edition formatting standards. 

• Use APA 7th edition headings to 

separate each (sub)section of the report/ 

essay. 

• Use page numbers and a running head. 

• Use APA 7th format for all tables and 

figures. While these can be presented 

either on their own page at the end of a 

paper following the References, or be 

positioned in the text of the document, 

for this course we want you to place 

tables and figures as close as is 

practically possible to the paragraph 

that refers to it (e.g., directly before or 

preferably just after). DO NOT place it 

in the middle of a paragraph. 

• Take time with the writing process: pre-

writing, drafting, revising, editing, and 

proofreading. 

• Use third person (e.g., passive 

specification of the subject of every 

sentence) or second person (e.g., 

“your”) perspective unless the 

instructor requests this. 

• Use gendered pronouns (e.g., “she” and 

“his”). 

• Use biased language (e.g., disabled 

people vs. people with disability). 

• Use directives i.e., “do this”, “do that.” 

• Use fragments i.e., incomplete 

sentences. 

• Write run-on sentences (i.e., two or 

more sentences that are joined without 

correct punctuation or connecting 

words). 

• Use informal, conversational tone. This 

includes the use of slang and idioms. 

• Use vague expressions e.g., “people”, 

“the company”. 

• Use jargon. If there is a simpler way of 

saying something, use it! 

• Create/invent acronyms. Unless an 

acronym is already established and 

well-known (e.g., MRI, ANOVA, 

SMR), it will only serve to confuse 

your reader. 

• Use ‘wordy’ writing styles. This 

includes flowery phrasing with too 

many adjectives, excessive use of 

complex terms, redundancy, 

unnecessary phrases that fill up space 

but don't add meaning, and any other 

techniques that increase the word limit 

but fail to add important information. 

• Use a descriptive or personal style of 

writing (unless explicitly requested by 

the instructor or assessment). 

• Start a sentence with a numeral. These 

should always be written out in words. 

Likewise for values less than 10. 

• Plagiarise. ALWAYS reference your 

sources of information and cite these 

correctly! 
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FORMAT GUIDELINES FOR TABLES 
 

• Tables must be referred to in the text of the report, at a time that is appropriate. 

• The table itself should be presented as close as practicable to its reference in 

the text (i.e., immediately before or after the paragraph that mentions it – do 

not place it in the middle of the paragraph). It is not necessary for a table to 

start on a new page unless it will not fit in its entirety on the previous page 

(this includes the table title and any relevant notes). 

• The table must be intelligible as a stand-alone piece of information, without 

reference to the text required to understand it. This includes having a clear title 

that encapsulates exactly what data the table holds, and notes that help 

interpret any information contained therein (including explanatory notes of 

any abbreviations and significance levels applied). 

• A table should appear on a single page, not split over two pages (this includes 

the title and any notes below). 

• The table itself should be aligned flush to the left of the page, not centred. 

• The title goes above the table. Uppercase is used to start each major word. 

• The label (i.e., “Table 1”) is presented in boldface type, on its own line and is 

not followed by a full-stop. 

• The actual title for the table should appear below this on the next line in 

italics, with uppercase letters to start each major word. Again, no full stop is at 

the end. Each table title should be clear and concise, summarising the key 

information contained within. 

• The title and notes for a table should be double-spaced, aligned to the left, and 

appear in the same font as the rest of the document. 

• The spacing for the table body itself can be single, 1.5 OR double spaced, to 

assist readability. 

• Font size within the table body must be legible (8-12pt), and appear in Times 

New Roman or Arial font (i.e., the font consistent with the rest of the 

document text). 

• The table has no vertical lines at all and borders should not be used around 

individual cells. 

• The spacing and alignment of table columns needs to be clear to allow for easy 

reading and distinguishing between the table elements. 

• The only horizontal lines are at the top and bottom of the table, as well as 

underneath the first row that specifies the column title (i.e., the name of the 

variable/ statistic in that column). More complex tables may require more 

horizontal lines to break up (sub)sections of the table or to help identify more 

variables/ variable levels within a table. 

• A note should be included under the table to make clear any symbols which 

appear in the table (e.g., abbreviations and significance of p-values). For this, 

general notes appear first, followed by specific notes and then probability level 

notes. Specific notes appear in a new paragraph (i.e., start a new line), while 

further specific notes follow on in the same paragraph. Notes regarding given 

probability/ significance levels also require a new paragraph. 

• If including a correlation matrix, only provide the values for the upper right or 

lower left triangle (i.e., do not repeat the correlations in a full matrix format). 

• Leave cells blank if not applicable/ relevant. 

• Any cells containing a dash require explanation in the notes below. 

• Entries within the table should be centered, unless alignment to the left assists 

readability (this usually occurs in instances of longer entries or those in the 

far-left column).
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• Numerals presented in a table need to be consistent regarding the number of 

decimal places displayed. This is determined by the precision of measurement 

and should never change in the same column. As a general rule: 

o Means and standard deviations should be rounded and presented to one 

decimal place, 

o Correlations, proportions and inferential statistics (e.g., t, F) are to be 

rounded and presented to two decimal places, and 

o Exact p-values are to be reported to three decimals. 

• Values that cannot exceed ±1 should NOT be presented with a 0 in front of the 

decimal place (e.g., correlations). This is demonstrated in Table 1 below, 

where the correlations, and mean and standard deviation for Sex (dummy-

coded as 0 = males, 1 = females) have no 0 in front of the decimal place, while 

the mean and standard deviation for Stress (the values of which have the 

potential to exceed 1) do. 
 

Example: 

NB: Although this table is based on the workbook exercises, some numbers have been 

changed for illustrative purposes. 

 

Table 1 

Descriptive Statistics and Intercorrelations between Eating Difficulty, Stress and Sex 

Variable M (SD) Stress Sex 

Eating Difficulty 12.9 (7.8) .51** .38* 

Stress 0.9 (0.2)  .13 

Sex .5 (.5)   

Note. Given no participants identified their sex as “other”, sex was dichotomously 

coded as “males” = 0 and “females” = 1. 

* p < .05. ** p < .01. *** p < .001. 

 

 

NOTES ON CREATING TABLES IN MICROSOFT WORD 
 

• Click Insert → Table and select the number of columns and rows required. 

• Write in the text/ values for each cell. Be sure to give the columns titles. 

• To change the borders, utilise these functions to add or delete border lines as 

necessary (these border functions are found under the Home tab). 
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FORMAT GUIDELINES FOR FIGURES 
 

• Figures are formatted in parallel to tables. That is, consistent rules are applied to 

both. 

• Figures must be referred to in the text, at a time that is appropriate. 

• APA 7th edition format allows for figures to be presented either in the text of the 

document or on their own page at the end of a paper after the References list. For 

this course we want you to position them as close as practically possible to their 

mention in the text (i.e., immediately before or after the paragraph that referred 

to that figure – do not place it in the middle of the paragraph). It is not necessary 

for the figure to start on a new page unless it will not fit in its entirety on the 

previous page (this includes the figure title and any relevant notes). 

• Graphs/ illustrations/ depictions should be referred to in the text as “Figure” 

NOT “Fig”. 

• Information in the figure should AUGMENT rather than duplicate the text. Be 

sure to state the key relationship(s) you want your reader to take away from the 

figure, but leave the details to them to work out. 

• The figure should be easy to read and understand as a stand-alone piece of 

information. 

• The figure itself should be aligned flush to the left of the page, not centred. 

• The title (caption) goes above the figure and takes the same format as that for a 

table. Uppercase is used to start each major word. 

• The label (i.e., “Figure 1”) is presented in boldface type, on its own line and is 

not followed by a full-stop. 

• The actual title for the figure should appear below this on the next line in italics, 

with uppercase letters to start each major word. Again, no full stop is at the end. 

• The figure title should be brief but descriptive. It should include the IVs (or IV 

levels) and DV(s) portrayed in the graph. 

o TOO BRIEF: Aggression Scores 

o BRIEF BUT SUFFICIENTLY DESCRIPTIVE: Aggression Scores as a 

Function of Alcohol Consumption and Alcohol Expectation 

• The title and notes for a figure are to be double-spaced, aligned to the left, and 

appear in the same font as the rest of the document. 

• A note should be included under the figure to explain any special symbols and/ 

or abbreviations used. For this, general notes appear first, followed by specific 

notes and then probability level notes. Specific notes appear in a new paragraph 

(i.e., start a new line), while further specific notes follow on in the same 

paragraph. Notes regarding given probability/ significance levels also require a 

new paragraph. 

• Axes and legends should be clearly labelled, with uppercase letters beginning 

each major word e.g., Alcohol Expectation. 

• Axes labels should appear in boldface type. 

• The magnitude/ scaling/ direction for the axes or grid elements needs to be made 

clear. 

• Legends (keys to the symbols used in figures) should be placed within the 

borders of the figure plot area where possible. 

• The entire figure must be large enough to be legible in both size and resolution. 

Font size should be no smaller than 8-point and no larger than 14-point. Further, 

the font should appear as Times New Roman or Arial (i.e., the same font used 

throughout the rest of the document). 

• Use distinct, geometric forms for differentiating lines or bars in your figure. 

o Good, distinct forms: 
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▪ Open circle versus solid circle line markers. 

▪ Light-shaded versus dark-shaded bars. 

o Examples that are NOT distinct enough: 

▪ Square versus circle line markers. 

▪ Black versus dark-shaded bars. 

• The top and right axes of the graph plot area should be removed. Only the 

bottom and left axes should be seen (i.e., the x and y graph axes). 

• There should be no outer border. 

• The background needs to be white, not grey. 

• The background should not have horizontal gridlines unless they are necessary 

for clarity. 

• The figure should appear in black and white (greyscale). Shading, patterns and 

colour should only be used for clarity. 

• Error bars should be included. These can represent either standard deviation or 

standard error values, but you must specify which and its scaling in the figure 

note e.g., Error bars indicate ±1 standard deviation from the mean. 

 

Examples: 

Figure 1 

The Effect of Alcohol Consumption on Mean Rated Aggression Levels as Moderated by 

the Expectation of Alcohol 

 

Note. Error bars represent ±1 standard deviation from the mean.
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Figure 2 

The Effect of Alcohol Consumption on Mean Rated Aggression Levels as Moderated by 

the Expectation of Alcohol 

 
Note. Error bars represent ±1 standard deviation from the mean. 

 



PSYC3010: FORMAT EXPECTATIONS  11 

 

 

CREATING LINE GRAPHS IN EXCEL 
 

 

1. Enter the data of the variable means and standard errors (or standard deviations) 

into the Excel spreadsheet. Place the means at the top and then enter the error 

estimates in the same order pattern as the means, but beneath them. By convention, 

order your variable levels from lowest to highest magnitude if possible. For example: 

 

 
 

 

2. Highlight your data for the means only, and under the Insert tab select the 

Insert Line or Area Chart icon. 

 

 
 

3. Under the Insert Line or Area Chart tab, select Line with Markers. 
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4. The graph will now appear, and the Chart Tools - Design tab will have 

automatically become active. Check that the graph looks appropriate (i.e., the correct 

variables are on the x-axis and/ or represented by the separate lines). If something is 

not quite right, you might have to select Switch Row/ Column. 

 

 
 

5. Now you need to spend some time formatting the graph to adhere to APA 7th 

guideline standards. There are several parts of the graph you can edit. To change 

formatting, you just right-click on the area you want to edit and change the details. 

The following are the most important areas to change, as well as a couple of hints 

about APA 7th format (though you will need to check this more thoroughly for 

yourself). There are seven main aspects of the graph that require editing in Excel. 

These are: Chart Title, Chart Area, Gridlines, Data Series, Error Bars (these will 

be missing on the initial graph, and you will need to add them), y-Axis and Legend. 

 

 
 

Note. This is the original line graph that appears in Excel. This is NOT yet edited to 

APA 7th standard. This is NOT an acceptable form in which to present your data! 

 

Data Series 

Legend 

Gridlines 

Chart Area 

y-Axis 

Chart Title 
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CHART TITLE 
 

6. Right-click on the Chart Title. From the drop-down menu that appears, select 

Delete. 

 

 
 

CHART AREA 
 

7a. Right-click within the chart area (not plot area) and select Format Chart Area. 
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7b. A Format Chart Area menu will appear on the right of screen. Click on the 

Border heading, and select No line. Close this window by clicking on the “X” in the 

top right-hand corner. 

 

 
 

 

GRIDLINES 
 

8. Right-click on one of the chart gridlines. Select Delete from the drop-down menu 

that appears. 
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DATA SERIES 
 

9a. Right-click on one line on your graph and select Format Data Series from the 

menu that appears. 

 

 
 

 

9b. A Format Data Series menu will appear on the right of screen. Click on the Fill & 

Line (1st) icon at the top left. Here you can change the shape, outline and colour of the 

data points and lines. Specifically, under the Line options, click Solid line and then 

select black as the Theme Colour from the drop-down menu. 
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9c. The best way to distinguish lines is by using distinct markers. For example, APA 

7th format suggests the use of open and closed circles. Alternatively, a circle and a 

triangle are considered more geometrically distinct – and are thus preferred over – a 

square and a diamond as line markers. 
 

To provide open and closed circles, under the Marker options, from the drop-down 

menu for Marker Options, click Built-in and select the circle shape from the menu 

for Type. Also increase the Size from 5pt to 7pt. 
 

 
 

 

9d. Then under the Fill heading, click Solid fill and select white here as the Theme 

colour, so that it appears as an open circle (while for the other line you would choose 

a black fill at this step so that it appears as a closed circle). 
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9e. So that the line around the marker itself appears as a solid black line, under the 

Border heading, click Solid line and select black as the Theme Colour from the 

drop-down menu. APA 7th format prefers that the lines are all black and of the same 

style (i.e., same solid line weight). Close the Format Data Series window. 
 

 
 

 

9f. Repeat this same process for the other line(s) in your graph. 
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ERROR BARS 
 

At this point you need to add error bars to your graph, which visually represent how 

confident you are about the accuracy of the means. In psychology we use either the 

standard error or the standard deviation for these error bars. Some journals or advisors 

prefer one over the other, in which case obey their commands. If you are free to 

choose, most people opt for the standard errors because they are smaller (which 

makes you look more accurate) and they are slightly more convenient to find in SPSS 

(e.g., if you have asked for tests of the simple effects). Each mean has its own error 

estimate. That is, if you have four means, you will have four error estimates. 

 

10a. Once you have found them – if you have not already – enter the error estimates 

into Excel in the same order pattern as the means, but underneath them. In the 

example below, 0.3 would be the standard deviation (SD) associated with the 3.2 

mean (i.e., did not expect alcohol/ no alcohol consumed), 0.55 would be the SD for 

the did not expect alcohol/ alcohol consumed mean 6.4, and 0.7 and 0.25 would be the 

SDs associated with the means 5.2 and 6.6, respectively. 

 

 
 

 

10b. Next, click on the chart and click on one of the lines (carefully noting which 

means it represents given by the values highlighted inside the box in the spreadsheet). 

Click on the “+” symbol next to the chart that represents Chart Elements, select the 

arrow next to Error Bars and choose More Options... 

 

 
 

 

10c. A Format Error Bars window will open on the right-hand side of the screen. 

Click on the Error Bar Options (third) icon at the top. You should confirm that Both 

is selected as the form of Vertical Error Bar to be displayed. That is, we want error 

bars that appear both up and down from the mean data points on the graph. Next, 

select Custom and click on Specify Value. 
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10d. The Custom Error Bars window will open. It will list the positive and negative 

error values as 1 by default. This means nothing and needs to be altered to match the 

actual error values for the line in question. To do this, click on the red arrow square 

next to the number for Positive Error Value. 

 

 
 

 

10e. Then use your cursor to highlight both of the errors (in our case, standard 

deviations – but this works the same for standard errors) associated with the line 

means in the spreadsheet. It will give you a crazy-looking formula. Hit Enter. 
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10f. Repeat this procedure by clicking the red arrow next to the Negative Error 

Value, highlighting the same cells (i.e., the standard deviations for the means of that 

same line) and hitting Enter. Click OK. At this point, one of your lines should have 

error bars and not the other. Double-check the distance of these error bars is identical 

above and below the mean circles for this line i.e., check that you didn’t accidentally 

highlight the wrong/ other row of cells for the Negative Error Value. 

 

 
 

10g. Don’t stop now. Add the error bars to the other line by clicking on that other 

line, selecting the “+” symbol next to the chart that represents Chart Elements, 

clicking the arrow next to Error Bars and choosing More Options... When the 

Format Error Bars window opens, click on the Error Bar Options (third) icon at the 

top. Confirm that Both is selected as the Vertical Error Bar display option. Click the 

button for Custom and then Specify Value. When the Custom Error Bars window 

opens, click on the red arrow square next to the number {1} for Positive Error 

Value. Then use your cursor to highlight both of the errors associated with this 

other line’s means in the spreadsheet (NB: these will be different from the first set of 

standard deviations/ errors you highlighted). When it comes up with a crazy-looking 

formula, hit Enter. Repeat this procedure for the Negative Error Value. Click OK. At 

this point, you may begin to revel, because both of your lines have error bars. 
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Y-AXIS 
 

11a. Right-click on the y-axis of the graph and choose Format Axis. 
 

 
 

 

11b. A Format Axis window will open on the right-hand side of the screen. Since a 7-

point rating scale (from 1 to 7) was used to measure Aggression levels (DV), the y-

axis should reflect this same scaling. To change the y-axis scale, click on the Axis 

Options (4th) icon and under the Axis Options → Bounds heading, change the 

Minimum scale value to 1. Also change the Maximum to 7. NB: Although it is ideal 

to have the maximum scale value the same as the maximum y-axis value, sometimes 

this value needs to be increased in order to accommodate the error bars – be mindful 

of this. 
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11c. Tick marks can be added for easier value reading for graphs. To do this, under 

the Tick Marks heading, select Outside from the drop-down menu for Major type. 
 

 
 

11d. If you wanted to change the number of decimal places displayed for the y-axis 

values, this is done under the Number heading by selecting Number from the 

Category drop-down menu. Then enter the desired number of decimal places. Recall 

that APA 7th format allows for either whole numbers, or 1 or 2 decimal places to be 

displayed, dependent upon the precision of measurement. Since we’re fine with whole 

numbers (as this represents the original scale units), we will leave this. 
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11e. To ensure that the y-axis itself has an axis line, click on the Fill & Line (1st) 

icon. Under the Line heading, make sure that Solid line is selected, along with black 

as the Colour. Then Close the Format Axis window by clicking the cross at the top 

right corner. 

 

 
 

 

11f. You’ll notice that the text colour for the numbers on the y-axis is grey rather than 

black. To amend this, click on Text Options and under the Text Fill heading click 

Solid fill and select black as the Theme Colour. 
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LEGEND 
 

12a. Right-click on the legend and select Format Legend. 
 

 
 

 

12b. A Format Legend window will open on the right-hand side of the screen. The 

Legend preferably should appear inside the confines of the graph area. This will 

depend on what your individual graph looks like, so it may take some trial-and-error 

with regard to the position of the Legend. However, this will be easier to determine if 

you first go to the Legend Options (3rd) icon and uncheck the box for Show the 

legend without overlapping the chart. In this particular case, the best Legend 

Position is Right. 

 

 
 

 

12c. APA 7th formatting requires no border surrounding the Legend. To ensure this is 

removed, click on the Fill & Line (1st) icon and under the Border heading, select No 

line. 
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12d. Again, you’ll notice that the text colour for the Legend is grey rather than black. 

To amend this, click on Text Options and under the Text Fill heading click Solid fill 

and select black as the Theme Colour. 
 

 
 
 

Close the Format Legend window. The plot area should now look like this: 
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13a. The x-axis also needs to be addressed in terms of an appropriate (black) colour 

for the axis line itself, as well as the text. To do this, right-click on the x-axis and 

select Format Axis. 
 

 
 

 

13b. A Format Axis window will open on the right-hand side of the screen. To ensure 

the x-axis has an axis line, click on the Fill & Line (1st) icon. Under the Line heading, 

make sure that Solid line is selected, along with black as the Theme Colour. 
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13c. Again, you’ll notice that the text colour for the x-axis is grey rather than black. 

To fix this, click on Text Options and under the Text Fill heading click Solid fill and 

select black as the Theme Colour. 

 

 
 

 

14a. Now, you will need to change the font of the axes and the legend to that required 

by APA 7th formatting standards. To capitalise the axes and legend IV level labels, 

simply change these in the Excel spreadsheet where you entered your data (if you 

did not already enter these variable names that way). Make sure the labels are 

informative. Also, it is convention (as well as more logical) to enter the levels of each 

IV from low to high (where this is possible). For example: 

 

 
 

 

14b. To ensure that the text itself for each axis is in appropriate APA 7th format, click 

on the axis and – using the tools under the Home tab – change it to Times New 

Roman 12pt or Arial 11pt font (consistent with the remainder of your document). 

Repeat this process for the Legend. 
 

 

14c. Some of the graph elements may become distorted during the process above and 

require you to manually re-size and re-position them e.g., the Legend and its contents. 

Be sure that everything can be read/ seen clearly and in its entirety. 
 

 

15a. To name your axes in Excel, click on the graph and then click on the “+” symbol 

next to the chart that represents Chart Elements and select the arrow next to Axis 

Titles. You will need to check the boxes for both Primary Horizontal and Primary 

Vertical. 
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15b. Give appropriate titles to both your horizontal and vertical axes. Include all 

relevant magnitude/ scaling/ direction information for the axes titles, as well as 

checking this for the axes themselves and the Legend. In our case, we need to make 

clear the scaling used for the DV Rated Level of Aggression, which was 1-7. The 

direction and magnitude of both our axes have already been made clear i.e., the y-axis 

has values 1 to 7 listed up the side, while the x-axis has the level of alcohol 

consumption clearly identified (no alcohol and alcohol). Likewise, the levels involved 

for the other factor have been made clear in the Legend. 

Make sure that the axes titles are in a font style and size consistent with APA 7th 

formatting standards. Recall that these labels should be presented in boldface type. All 

this is done by clicking on the axis title itself and then entering the new title and 

formatting it via tools under the Home tab. It may be necessary to manually centre 

your titles over their respective axes. 

 

NB: We would NOT recommend giving the figure a title in Excel. It is much easier to 

type the title in Word above the graph (and relevant notes below it), after you have 

pasted it into the relevant document. 

 

 
 

 

16a. Once you are happy that your graph complies with APA 7th formatting standards, 

move it into a Word document by simply right-clicking within the chart area and 

selecting Copy. 
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16b. Open the Word document in which you wish the graph to appear. Place your 

cursor on the spot where you want the graph to go, and right-click. Select Paste from 

the drop-down menu options that are presented. Your graph will appear in your Word 

document. This figure should be aligned flush to the left of the page (rather than 

centred). 
 

 

17. For the final step, you need to give the figure a title consistent with APA 7th 

format requirements (now that it is in your Word document). The title – like that for a 

table – will appear above the figure, with any relevant notes placed beneath. Further, 

the “Figure 1” section of the title needs to be bolded, while the title itself is italicised. 

Usually, the figure title identifies the DV and the IVs (or IV levels). Notes should 

identify the type and magnitude of error bars employed. For example: 

 

Figure 1 

The Effect of Alcohol Consumption on Mean Rated Aggression Levels as Moderated 

by the Expectation of Alcohol 

 
Note. Error bars represent ±1 standard deviation from the mean. 
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CREATING BAR GRAPHS IN EXCEL 
 

1. Enter the data of the variable means and standard errors (or standard deviations) 

into the Excel spreadsheet. Place the means at the top and then enter the error 

estimates in the same order pattern as the means, but beneath them. By convention, 

order your variable levels from lowest to highest magnitude if possible. For example: 
 

 
 

 

2. Highlight your data for the means only. Then under the Insert tab, click on 

Insert Column or Bar Chart and select 2-D Column: Clustered Column from the 

drop-down menu. 
 

 
 

 

3. The graph will now appear, and the Design tab (under Chart Tools) will have 

automatically become active. Check that the graph looks appropriate (i.e., the correct 

variables are on the x-axis and/ or represented by the separate bars). If something is 

not quite right, you might have to select Switch Row/ Column. 
 

 
 

 

4. Now you need to spend some time formatting the graph to adhere to APA 7th 

standards. There are several parts of the graph you can edit. To change formatting, 

you just right-click on the area you want to edit and change the details. Follow the 

steps outlined above (in the Creating Line Graphs in Excel section) to ensure the 

Chart Title, Chart Area, Gridlines, Data Series, Error Bars (these will be missing 

on the initial graph, and you will need to add them), y-Axis, and Legend are all in 

appropriate APA 7th format. 
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Note. This is the original bar graph that appears in Excel. This is NOT yet edited to 

APA 7th standard. This is NOT an acceptable form in which to present your data! 

 

5a. You will need to change the font of the axes and the legend to that required by 

APA 7th formatting standards. To capitalise the axes and legend IV level labels, 

simply change these in the Excel spreadsheet where you entered your data (if you 

did not already enter these variable names that way). Make sure the labels are 

informative. Also, it is convention (as well as more logical) to enter the levels of each 

IV from low to high (where this is possible). For example: 
 

 
 

5b. To ensure that the text itself for each axis is in appropriate APA 7th format, click 

on the axis and – using the tools under the Home tab – change it to Times New 

Roman 12pt or Arial 11pt font (consistent with the remainder of your document). 

Repeat this process for the Legend. 

 

5c. Some of the graph elements may become distorted during the process above and 

require you to manually re-size and re-position them e.g., the Legend and its contents. 

Be sure that everything can be read/ seen clearly and in its entirety. 

 

6a. To name your axes in Excel, click on the graph and then click on the “+” symbol 

next to the chart that represents Chart Elements and select the arrow next to Axis 

Titles. You will need to check the boxes for both Primary Horizontal and Primary 

Vertical. Follow the instructions listed in the previous Creating Line Graphs in 

Excel section. 

 

6b. Give appropriate titles to both your horizontal and vertical axes. Include all 

relevant magnitude/ scaling/ direction information for the axes titles, as well as 

checking this for the axes themselves and the Legend. In our case, we need to make 

clear the scaling used for the DV Rated Level of Aggression, which was 1-7. The 

Chart Area 

Legend 

y-Axis 

Data Series 

Gridlines 

Chart Title 
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direction and magnitude of both our axes have already been made clear i.e., the y-axis 

has values 1 to 7 listed up the side, while the x-axis has the level of alcohol 

consumption clearly identified (no alcohol and alcohol). Likewise, the levels involved 

for the other factor have been made clear in the Legend. 

Make sure that the axes titles are in a font style and size consistent with APA 7th 

formatting standards, including being presented in boldface type. It may be necessary 

to manually centre your titles over their respective axes. 
 

NB: Again, we would NOT recommend giving the figure a title in Excel. Instead, 

type the figure title (caption) in Word above the graph (and relevant notes below it), 

after you have pasted it into the relevant document. It should look like the following: 

 

Figure 1 

The Effect of Alcohol Consumption on Mean Rated Aggression Levels as Moderated 

by the Expectation of Alcohol 

 
Note. Error bars represent ±1 standard deviation from the mean. 

A Couple of Extra Notes on Creating Bar Graphs in Excel: 
 

• The shading of the bars can be altered in the same way the data points (i.e., Data 

Series) of line graphs are changed. Choose bars which are maximally distinctive. 

Patterned bars should not be used unless there are more than 2 levels of the IV. 

Black bars should be avoided, as the error bars will not be visible against this 

colour. Ideally, opt for light grey (or even white) and dark grey (as above). While 

colours and patterns can be used, they should only be employed for clarity. In 

doing so, keep in mind to use high-contrast colours/ patterns that individuals with 

visual difficulty (including colour-blindness) will be able to distinguish easily. 
 

• The error bars for bar graphs should be created in the same manner outlined in the 

previous section on Creating Line Graphs in Excel. Again, this means that you 

will need to track down the standard error or standard deviation values associated 

with each mean in order to do this. You will then need to enter these values into 

Excel in the same configuration pattern as the means with which they are 

associated. Then follow the steps listed in the previous section to complete this 

procedure. 
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ALTERNATIVE METHOD TO CREATING STANDARD ERROR BARS 
(with thanks to Yolanda Gribble, School of Psychology) 

 

There may be times when you do not have a standard error value for each individual 

mean in your dataset, but rather standard error values for each simple slope or simple 

effect that was conducted. These standard error values would be associated with 

more than one mean each (i.e., they would be associated with one line on your line 

graph or one colour of bar on your bar graph each). If this is the case, the below 

outlines an alternative way to construct your standard error bars for your graph. 

 

1. To insert these standard error bars, click on the chart and click on one of the lines/ 

bars. Click on the “+” symbol next to the chart that represents Chart Elements, select 

the arrow next to Error Bars and choose More Options... 
 

 
 

2. A Format Error Bars window will open on the right side of the screen. Click on the 

Error Bar Options (3rd) icon at the top. Confirm that Both is selected as the form of 

Vertical Error Bar. That is, we want error bars that appear both up and down from the 

mean data points on the graph. Next, select Fixed Value and enter the standard error 

value (from your data) SEPARATELY for each data series (i.e., variable level). That is, 

one value will be entered as the standard error for one line on your line graph or one bar 

colour on your bar graph, while a different value will be entered later for the other(s). 

Enter as many decimal places as you have, to maximise accuracy. Close the window. 
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Note: If the error bars are too large, you may need to increase the y-axis scale 

maximum value to accommodate this. The error bars should be seen in their entirety 

on the graph. This is why we state the scaling used in the y-axis label to let the reader 

know the original scale employed i.e., Rated Level of Aggression (1-7). 
 

 

3. Using the instructions outlined in Creating a Line Graph in Excel, move your 

graph into a Word document. 
 

 

4. For the final step, you need to give the figure a title (i.e., caption) consistent with 

APA 7th format requirements (now that it is in your Word document). The title – like 

that for a table – will appear above the figure (with any relevant notes below it). The 

“Figure 1” section of the title needs to be bolded, while the title itself is italicised. It is 

very important when using error bars to make a note below the figure that 

identifies what these bars represent regarding the type and magnitude (see 

below). For example: 

 

Figure 1 

The Effect of Alcohol Consumption on Mean Rated Aggression Levels as Moderated 

by the Expectation of Alcohol 

 
Note. Error bars represent ±1 standard error from the mean. 
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FORMAT TIPS FOR BETWEEN GROUPS 
(INDEPENDENT GROUPS) FACTORIAL ANOVA 

 

STRUCTURE OF THE OVERALL WRITE UP 
 

1. State what kind of analysis was performed, identifying the IVs and the DV. This 

includes specifying the levels of the IV(s). Don’t forget that we tend to make use 

of conventional notation for this, which communicates a lot of information in few 

words (see tutorial slides). If this is the first time you have used the term ANOVA 

in the text, this acronym/ abbreviation must be written out properly and 

introduced i.e., analysis of variance (ANOVA). 

2. Report results of the first main effect, stating the significance and direction. Also 

include main effect follow-up tests (i.e., main effect comparisons) if this main 

effect was significant and the IV had more than two levels. If main effect 

comparisons were required, hold off on reporting the direction of effect until you 

present these. 

3. Report results of the second main effect, stating the significance and direction. 

Include main effect follow-up tests (i.e., main effect comparisons) if the main 

effect was significant and the IV had more than two levels. Again, if main effect 

comparisons were used, wait to report the direction of effect until reporting these. 

4. Report the significance of the interaction. If it was significant, include a graph 

showing the interaction and refer the reader to this figure in the text. 

5. Report any necessary follow-up tests for the interaction (i.e., simple effects). 

(a) If these simple effects only contain two levels, then describe their 

significance and direction. 

(b) If the simple effects contain more than two levels, further follow-up tests 

(i.e., simple comparisons) need to be performed. So first, report the 

significance of each simple effect. Then for the significant ones, go on to 

report the significance and direction of their follow-up simple comparisons. 

 

The example write-ups below use the SPSS output (and hand calculations) generated 

from the Drug Dosage x Sex experiment in Activity 2 and Activity 3 of the 

PSYC3010 Tutorial Workbook. 

 

An Important Note Regarding APA 7 vs. SPSS Output 
 

While APA 7th format edition asks that effect sizes, appropriate statistics and 

confidence intervals (CIs) be reported for all statistics/ point estimates, there is a 

mismatch between what APA 7 requires and the statistics/ output offered through the 

SPSS program. 
 

For example, SPSS only offers partial eta-squared (ηp
2) as an effect size for the F-tests 

for ANOVA, despite the fact that this provides an inflated estimate of the variance 

explained by a factor. Recall that it is preferable to report either eta-squared (η2) or 

omega-squared (ω2) instead. These need to be calculated by hand, based on values 

provided by SPSS in the ANOVA Test of Between-Subjects Effects table. 
 

There is also no effect size available through SPSS for follow-up main or simple 

comparison t-tests. However, output values regarding the relevant group means and 

standard deviations from SPSS can be input into free online calculators to compute 

Cohen’s d for t-tests. An example of such an online calculator can be found at: 

https://www.socscistatistics.com/effectsize/default3.aspx  
 

https://www.socscistatistics.com/effectsize/default3.aspx
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Similarly, the actual t-values for follow-up main and simple comparisons are omitted 

from SPSS. Instead, output tables supply only a mean difference score for 

comparisons. Yet these values are not intelligible in isolation, as they are not 

expressed relative (or as a ratio) to the standard error present within the data. That is, 

a mean difference of any size or magnitude between two groups (i.e., treatment effect) 

does not mean much unless we also consider how much we expect scores to differ just 

by chance (i.e., error variability). Fortunately, however, the t-values can be calculated 

relatively easily from the information provided in the Multiple Comparisons and 

Pairwise Comparisons tables, respectively. Specifically, the t-value for the given 

comparison is generated by dividing the relevant comparison’s mean difference score 

by its associated standard error. These values are located in the first two columns of 

the table. The degrees of freedom (df) reported with the t-test is that for error (found 

in the Tests of Between-Subjects Effects table). 
 

A further issue is that within SPSS no confidence intervals are given for F-test results. 

If these are available to you however, they should always be reported. When reporting 

confidence intervals within the text, APA 7th format only requires that the % span of 

the confidence intervals be stipulated the first time they are used within a paragraph or 

within an analysis e.g., 95% CI [Lower, Upper]. After this, the percentage should not 

be repeated i.e., CI [Lower, Upper]. 
 

Comparable to the issue with t-values, SPSS also does not provide the required 

confidence intervals for pairwise comparisons. Instead of supplying the 95% CIs for a 

t-value, it presents those for the mean difference score for comparisons. Again, these 

are not particularly useful as they do not account for the amount of error present 

within the data. Yet again, the necessary calculations to derive the 95% CIs for t are 

relatively easy and can be performed based upon the information supplied in the 

Multiple Comparisons table (for main effect comparisons) and Pairwise Comparisons 

table (for simple effect comparisons). Specifically, the lower bound 95% CI value for 

t for a given comparison is generated by dividing the existing relevant comparison’s 

lower bound 95% CI value for the mean difference score (located in the second last 

column) by its associated standard error (located in the second column). A similar 

procedure is employed to determine the upper bound 95% CI value for t, where the 

existing relevant comparison’s upper bound 95% CI value for the mean difference 

score (located in the last column) is divided by its associated standard error (located in 

the second column). Always check that these 95% CI values flank the t-value 

correctly. That is, the t-value of interest should always be positioned perfectly in the 

middle of the two reported CI values (minus rounding considerations), with equal 

distances between the t-value and each of the lower and upper bound values. 

 

WRITING UP RESULTS OF A MAIN EFFECT THAT HAS ONLY TWO LEVELS 
 

1. Using full sentences, state in words whether or not the main effect (in this case, 

of sex) was significant. Back up this statement with statistics in APA format. 
 

Example of APA 7th Format for Reporting Statistics for a Main Effect: 
 

F(3, 32) = 18.29, p < .001, ω2 = .13 
 

• Notice that the symbols for the statistics F and p are italicised. All statistics in 

English/ Latin letters should be. Note though that ω2 and all other statistics 

that use Greek symbols should not be italicised. Instead, all Greek-lettered 

notation should appear in standard text. 
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• When reporting the effect size, η2 is acceptable, although some prefer ω2. 

Despite the fact that ηp
2 (partial η2) is used in journal articles, it is not 

recommended as it provides an inflated effect size value. 

• Notice that the statistics (F, η2and ω2) only go to two decimal places. 

• In contrast, the p-value goes to three decimal places. 

• For values that cannot potentially exceed ±1 (e.g., ω2 and p), there is NO zero 

placed BEFORE the decimal place. 

• Notice the spacing between elements of the statistical notation. I.e., it is not all 

run together, but rather is separated out for reader clarity. 

• The p-value reported here is converted to “< .001”, and is not reported as “= 

.000” even though SPSS gave the significance as the latter. You should never 

report a p-value as equal to either .000 or 1.000. Instead, you should report 

these as p < .001 and p > .999, respectively. 

• Lastly, it is important to note that if you had used a statistics program where 

you had access to the confidence intervals for the F-test, you would always 

report these statistics (following the effect size). 

 

2. Next, report the direction of the effect in words (e.g., male rats performed 

significantly better on the maze running task than females). Provide evidence for 

this statement with statistics. Namely, report the marginal means and standard 

deviations for each level of the sex factor: 
 

Example of APA 7th Format for Reporting Means and Standard Deviations in Text: 
 

When describing each level in the text, you could report each group’s M and SD 

after you mention that group within the sentence, like this: 

(M = 10.9, SD = 1.7) 
 

Alternatively, you could describe the direction fully and at the end of the sentence 

report both Ms and SDs, like this: 

(M = 10.9, SD = 1.7, and M = 9.3, SD = 2.4, respectively) 
 

• Notice again, that the symbols for the statistics (M and SD) are italicised. 

• Also, the statistics (M and SD) only go to one decimal place (due to the 

precision of measurement used). 

 

WRITING UP RESULTS OF A MAIN EFFECT THAT HAS MORE THAN TWO LEVELS 
 

Remember that if a main effect is significant and the factor has more than two levels, 

you have to perform follow-up main effect comparisons using either pairwise t-tests 

(through SPSS) or linear contrasts (via hand calculations or complicated SPSS 

syntax). 
 

1. Firstly though, report the significance of the main effect (as in point 1 for a main 

effect for a factor with only two levels). 
 

2. Then state what kind of test was done to follow-up the significant main effect 

(i.e., main comparisons were performed using pairwise t-tests or linear contrasts). 

If a correction was used, specify which correction and why. Regardless of 

whether or not a correction was used, state the number of comparisons performed 

and their α-level. 



PSYC3010: FORMAT EXPECTATIONS  38 

 

 

3. For each follow-up test, report the results in words, stating the significance. Back 

this up with appropriate statistics. 

Note that APA 7 asks for an effect size and confidence intervals to be included in 

this statistical notation. While not given directly, the 95% confidence intervals 

can be determined from the SPSS output. However, an effect size is not provided. 

Yet these can be computed if needed using an online statistics calculator for 

Cohen’s d. An example of such an online calculator is found at: 

https://www.socscistatistics.com/effectsize/default3.aspx  

For this, you need to input the relevant mean (M), standard deviation (s) not 

standard error, and sample size (n) values for the two groups involved in the t-

test. As an example, for the main comparison t-test for zero versus small drug 

dosage: 

Zero: M = 8.0000, s = 1.56347, n = 10 

Small: M = 12.3000, s = 0.94868, n = 10 

This gives a Cohen’s d value of 3.33. 
 

Examples of APA 7th Format for Reporting Follow-Up Statistics of a Main Effect: 
 

Pairwise t-test from SPSS output: 

t(32) = -8.13, p < .001, d = 3.33, 95% CI [-10.16, -6.09] 
 

• This is the correct reporting for a pairwise t-test main effect comparison 

conducted through SPSS, with the effect size computed online via a Cohen’s d 

calculator. 

• Note that the p-value reported here is exact (i.e., was stated by SPSS as “.000”), 

because it was available in the SPSS output. 

• Also note that t-values, Cohen’s d and confidence intervals are reported to two 

decimal places, while p-values are given to three decimals. 

• While not provided in the example above, since t-values, Cohen’s d and 

confidence intervals can all potentially exceed a value of ±1, if any had been 

below this, a zero would appear before the decimal place (e.g., d = 0.86). 

• Again, take note of the spacing applied between the statistical notation 

elements. 
 

Linear contrast performed by hand calculation: 

t(32) = -8.13, p < .05 
 

• Notice that the p-value reported here is simply given as “p < .05” because this 

statistic was based on hand calculations, so it’s the best we can do. Exact p-

values should always be reported if they are available. 

• If you had made use of a Bonferroni correction for this, don’t forget to report 

the ’ (i.e., prime sign) next to the t! This would look like: t’(32) = -8.13, p < 

.001, d = 3.33, 95% CI [-10.16, -6.09] and t’(32) = -8.13, p < .05 for a t-test 

comparison performed via SPSS and hand-calculated linear contrast, 

respectively. 
 

4. Be sure to describe the direction, backing up your verbal statement with marginal 

means and standard deviations reported in APA format (as outlined previously). 

Note that when reporting multiple comparisons that use the same group more 

than once, DO NOT repeat any Ms and SDs that have already been given in the 

text. 

https://www.socscistatistics.com/effectsize/default3.aspx
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Example 1: Overall, male rats (M = 10.9, SD = 1.7) performed significantly better 

than female rats (M = 9.3, SD = 2.4) on the maze running task. 
 

Example 2: The significant main effect of drug dosage was followed up by a series of 

main comparisons, using four pairwise t-tests at α = .05 each. Results revealed that 

rats with zero dosage (M = 8.0, SD = 1.6) performed significantly worse than those 

given either a small (M = 12.3, SD = 0.9), moderate (M = 10.0, SD = 1.3), or large (M 

= 9.9, SD = 2.2) amount of the steroid drug, t(32) = -8.13, p < .001, d = 3.33, 95% CI 

[-10.16, -6.09]; t(32) = -3.78, p = .001, d = 1.38, CI [-5.82, -1.74]; and t(32) = -3.59, p 

= .001, d = 0.99, CI [-5.63, -1.55], respectively. However, rats with a small steroid 

dose performed significantly better than those with a large dosage, t(32) = 4.54, p < 

.001, d = 1.40, CI [2.50, 6.57]. 
 

Take note that the positive or negative valence of the reported t-value indicates the 

direction of effect. That is, a positive t-value indicates that the first reported group 

involved in the comparison had a higher mean than the second group [i.e., (first group 

mean – second group mean) / standard error]. In contrast, a negative t-value indicates 

that the first reported group involved in the comparison had a lower mean than the 

second group. Always check that your t-value sign matches the direction reported in 

the text. Further, make sure that your confidence intervals span the given t-value 

properly. That is, a significant negative t-value will likewise have two negative CI 

values, a significant positive t-value will have two positive CI values, and a non-

significant t-value (whether positive or negative) will have a negative lower bound CI 

value and a positive upper bound CI. In all cases, the t-value itself should sit directly 

in the centre of the reported CI values. 

 

WRITING UP RESULTS OF A SIGNIFICANT INTERACTION 
 

1. State whether or not the interaction was significant, and back up your statement 

using the appropriate statistics (reported in APA 7th format). 
 

Example of APA 7th Format for Reporting Statistics of an Interaction: 
 

F(3, 32) = 4.91, p = .006, ω2 = .09 
 

• Notice that the p-value reported here is precisely .006. Again, exact p-values are 

to be given if they are available (which they are in SPSS output). 

• When reporting the effect size, η2 is acceptable, although ω2 is preferred. Again, 

although ηp
2 is often used in the industry, it is not a desirable measure of effect 

size. 

• Note that inferential statistics (such as F) and effect sizes should be reported to 

two decimal places, while the p-value is presented to three decimals. 

• For values that cannot potentially exceed ±1 (e.g., ω2 and p), there is NO zero 

placed BEFORE the decimal place. 

• Again, notice the spacing provided between the statistical notation elements to 

aid reader clarity. 

• Also, again, note that if you had used a statistics program where you had access 

to the confidence intervals for the F-test, you would always report these 

statistics (following the effect size). 

 

2. If the interaction is significant, state which set of simple effects you performed to 

follow-up this effect. Also include a figure of the interaction, and refer the reader 

to this in the text. 
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3. Then report the simple effects, stating their significance. If the simple effect is for 

a variable with only two levels, also report its direction and back this up with cell 

means and standard deviations. Note that simple effects are reported with an 

effect size. Similar to the interaction, if confidence intervals were available for 

your simple effects F-tests, these would be reported after the effect size notation. 

 

Example of APA 7th Format for Reporting Statistics for a Simple Effect: 
 

F(3, 32) = 6.32, p = .002, ω2 = .12 

 

4. If there is a significant simple effect for a variable with more than two levels, you 

will need to perform follow-up tests to find out exactly where the difference(s) lie 

(i.e., simple comparisons using either pairwise t-tests or linear contrasts). State 

which type of test you performed. If a correction was used, specify which 

correction and why. Regardless of whether or not a correction was used, state the 

number of comparisons performed and their α-level. 

 

5. Report the significance and direction of the simple comparisons, backing up your 

statements with the relevant statistics in APA style. 

Note again that APA 7 asks for an effect size and confidence intervals to be 

included in this statistical notation. Recall that the 95% confidence intervals can 

be determined from the SPSS output (with a little work). However, the effect size 

– in the form of Cohen’s d – will need to be computed. This can be done via a 

free online statistics calculator such as: 

https://www.socscistatistics.com/effectsize/default3.aspx  

Similar to main comparisons, you will need to input the relevant mean (M), 

standard deviation (s) not standard error, and sample size (n) values for the two 

groups involved in the t-test. 

As an example, for the simple comparison t-test for male rats comparing small 

and large drug dosages: 

Males 

Small: M = 12.0000, s = 1.22474, n = 5 

Large: M = 11.6000, s = 1.14018, n = 5 

This gives a Cohen’s d value of 0.34. 

 

Example of APA 7th Format for Reporting a Simple Comparison: 
 

Pairwise t-test from SPSS output: 

t(32) = 0.53, p = .597, d = 0.34, 95% CI [-1.50, 2.57] 
 

• This is the correct reporting for a pairwise t-test simple effect comparison 

conducted through SPSS, with the effect size computed online via a Cohen’s d 

calculator. 

• Note that the p-value reported here is exact, because it was available in the 

SPSS output. 

• Once again, take notice that t-values, Cohen’s d and confidence intervals are 

presented to two decimal places, while p-values are reported to three decimals. 

• Also note that since t-values and Cohen’s d can potentially exceed a value of 1, 

there is a zero given before the decimal place for these. 

• Be sure to apply the appropriate notation spacing when presenting these 

statistics in the text. 

https://www.socscistatistics.com/effectsize/default3.aspx
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Linear contrast performed by hand calculation: 

t(32) = 0.53, p > .05 
 

• Notice that the p-value reported here is simply given as “p > .05” because this 

statistic was based on hand calculations, so it’s the best we can do. Exact p-

values should always be reported if they are available. 

• If you are making a Bonferroni correction to the α-level used, don’t forget to 

include the ’ (i.e., prime sign) next to the t. E.g., t’(32) = 0.53, p = .597, d = 

0.34, 95% CI [-1.50, 2.57] and t’(32) = 0.53, p > .05 for a t-test comparison 

performed via SPSS and hand-calculated linear contrast, respectively. 

 

...and reporting the direction will require cell means and standard deviations: 
 

…The average maze running performance for male rats in the zero drug group (M 

= 9.0, SD = 1.4) was significantly lower than that for male rats in the small, 

moderate or large dosage conditions (M = 12.0, SD = 1.2; M = 10.8, SD = 1.3; and 

M = 11.6, SD = 1.1, respectively), t(32) = -4.01, p < .001, d = 2.27, 95% CI [-6.05, 

-1.97], t(32) = -2.41, p = .0.22, d = 1.32, CI [-4.44, -0.37], and t(32) = -3.48, p = 

.001, d = 2.02, CI [-5.51, -1.44], respectively. 
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FORMAT TIPS FOR STANDARD MULTIPLE REGRESSION 
 

*Note: The eating difficulty exercise from tutorials has been used in this section. 

However, some numbers have been changed for illustrative purposes. 

 

An Important Note Regarding APA 7 vs. SPSS Output 
 

While APA 7th format edition asks that effect sizes and confidence intervals be 

reported for all statistics/ point estimates, there is a mismatch between what APA 7 

requires and the statistics/ output offered through the SPSS program. 
 

For example, while SPSS offers an effect size for correlations and overall regression 

models (in the form of r or r2 and R2, respectively), confidence intervals are not 

provided for these statistics. Further, while confidence intervals are given by SPSS for 

the individual coefficients within a regression model, these are only available for b 

weights rather than β weights. Recall that we prefer to use β over b values for all the 

reasons outlined in lectures and tutorials (i.e., they are standardised coefficient 

weightings and therefore, can be compared among the variables within a regression 

model to determine which are the strongest/ weakest predictors). However, the 95% 

CI values for b can be converted into confidence intervals for β, based on the 

information SPSS supplies. As such, you should perform these extra calculations and 

report these 95% confidence interval values for β when providing the statistics for the 

individual predictor contributions. 

 

To generate these 95% CI values for β from those given for b in SPSS, we need to 

first work out the coefficient ratio between b and β for the predictor of interest. This is 

achieved by dividing b by β for the relevant predictor (these values are located in the 

first and third columns, respectively, of the Coefficients table). The lower bound 95% 

CI value for β for a given individual model predictor is then calculated by dividing the 

existing relevant predictor’s lower bound 95% CI value for b (located in the sixth 

column) by the associated coefficient ratio you just worked out (i.e., b / β). A similar 

procedure is employed to determine the upper bound 95% CI value for β, where the 

existing relevant predictor’s upper bound 95% CI value for b (located in the seventh 

column) is divided by the associated coefficient ratio. Ensure your 95% confidence 

intervals span the given β value properly. That is, a significant negative β value will 

likewise have two negative CI values, a significant positive β value will have two 

positive CI values, and a non-significant β value (whether positive or negative) will 

have a negative lower bound CI value and a positive upper bound CI. In all cases, the 

β weight itself should be positioned perfectly in the middle of the two reported CI 

values (minus rounding considerations), with equal distances between β and each of 

the lower and upper bound values. 
 

NB: Remember that when reporting confidence intervals within the text, APA 7th 

format only requires that the % span of these be stipulated the first time they are used 

within a paragraph or within an analysis e.g., 95% CI [Lower, Upper]. After this, the 

percentage should not be repeated i.e., CI [Lower, Upper]. 

 

WRITING UP RESULTS OF A STANDARD MULTIPLE REGRESSION 

 

1. Describe the multiple regression analysis that was conducted, identifying the 

criterion and the predictors involved. If this is the first time you have used the 

acronym/ abbreviation for your regression type in the text, it must be written out 

properly and introduced i.e., standard multiple regression (SMR). 
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2. Conduct preliminary checks: Report the zero-order correlations between each 

predictor and the criterion (these are known as validities), as well as the 

intercorrelations between the predictors themselves (these are known as 

collinearities). Be sure to report the two-tailed tests of significance (i.e., p-values) 

for these! The reporting of preliminary checks is usually done in the text, with 

reference to a table that contains the means, standard deviations and zero-order 

correlations. Also be sure to mention explicitly which predictors were valid/ not 

valid within the regression model, and comment whether collinearity was at a 

problematic level overall. Generally speaking, if no correlations among the 

predictors exceed a threshold of r = ±.70, collinearity is not problematic (as this 

indicates no predictors overlap more than 50% – as given by r2 – with one another 

and therefore, none are redundant within the model). 

 

 NB: If you have a dichotomous variable (such as the predictor sex as we have 

here), you will need to describe the zero-order difference in the criterion, because 

a ‘positive’ or ‘negative’ correlation will not make sense (i.e., it could mean 

different things depending on how the coding was performed). For example: 

“Females displayed significantly higher eating difficulty levels than males.” 

 

Example of Correlation Matrix, in APA 7th Format Style: 

 

Table 1 

Descriptive Statistics and Intercorrelations between Eating Difficulty, Stress and 

Sex 

Variable M (SD) Stress Sex 

Eating Difficulty 12.9 (7.8) .51** .38* 

Stress 14.4 (7.1)  .13 

Sex .5 (.5)   

Note. Given no participants identified their sex as “other”, sex was dichotomously 

coded as “males” = 0 and “females” = 1. 

* p < .05. ** p < .01. *** p < .001. 

• Notice that the title goes above the table. The section “Table 1” is bolded. 

However, the title itself (i.e., “Descriptive Statistics and Intercorrelations…”) 

starts on a new line and is italicised. The first letter of each major word of the 

title should appear as an uppercase (capital) letter. 

• The title and any notes are to be double spaced. The table body itself can be 

single, 1.5 or double spaced. 

• Observe that the values for means (M) and standard deviations (SD) are 

reported to only one decimal place (due to the precision of measurement 

used). 

• In contrast, correlations (r) are reported to two decimals. Values within a 

column should never differ in terms of the number of decimal places 

displayed. 

• Correlations do not require a 0 in front of the decimal place, as these cannot 

range above an absolute magnitude of 1. It is important that the means and 
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standard deviations are reported with a 0 in front of the decimal place, as these 

can range above an absolute magnitude of 1, except in the case of sex (which 

was dichotomously coded as 0 = “males” and 1 = “females”). 

• Note that the significance for correlations is denoted with asterisks (the code 

for which is given below the table). The convention is * p < .05, ** p < .01 

and *** p < .001. These are presented with full stops in between. Sometimes † 

p < .10 is used to denote marginal significance (e.g., p = .060). All three 

asterisk notations must be provided below the table – you cannot chop and 

change as the symbols for these specific significance levels are conventions of 

the psychology discipline and industry reporting standards! 

• The table has no vertical lines at all. The only horizontal lines are at the top 

and bottom of the table, as well as underneath the first row that specifies the 

column title (i.e., the name of the variable/ statistic contained therein). 

• If including a correlation matrix, only provide the values for the upper right or 

lower left triangle (i.e., do not repeat the correlations in a full matrix format). 

• Cells with irrelevant or redundant information should be left blank. Do not add 

dashes to these. Dashes should only be used when missing information in a 

cell requires explanation (which would be supplied in the notes below). 

 

3. Describe the analysis of regression. That is, describe the proportion of variance in 

the criterion that is explained by the predictors taken together (i.e., R2 expressed as 

a percentage in the text), and state the significance/ non-significance. Provide the 

statistical notation for the test of significance and significance level at the end of 

the sentence i.e., F(df) and p. 

 

Example of APA 7th Format for Reporting Statistics of the 
Overall Model in a Standard Multiple Regression: 

 

Together, stress and sex significantly explained 36% of the variance in eating 

difficulty scores, F(2, 37) = 10.46, p < .001. 

 

• Note that R2 is reported as a percentage in the text (i.e., 36%). If the 

percentage is < 1%, it should be rounded and reported as either 1% (if it 

rounds up) or “less than 1% of the variance” (if it rounds down). You should 

not report 0% R2. 

• If confidence intervals are available for your R2 value, these would be 

presented at the end of the statistical notation following the p-value. 

 

4. Next, report the findings for the individual predictors. Specifically, describe the 

unique contributions of the individual predictors, reporting their significance/ non-

significance, direction of effect, βs, t-values, degrees of freedom, p-values and the 

95% confidence intervals associated with these. Also describe how much of the 

total variance in the criterion was explained uniquely by each of the predictors 

(i.e., their sr2 value expressed as a percentage in the text). 

 

Further, also comment on the respective importance of each predictor, particularly 

if it is tied to your research questions/ hypotheses. To determine the significance 

of this predictor strength order, use and report Fisher-Z test results. While these 

are not provided in SPSS, they can be ascertained via free online calculators such 

as: https://www.psychometrica.de/correlation.html  

https://www.psychometrica.de/correlation.html
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IF YOUR MODEL HAS ONLY TWO PREDICTORS: 

For this, choose “Comparison of correlations from dependent samples” (as we 

are comparing the strength of predictors within the same dataset, generated by the 

same participants). Then input information regarding the relevant: 

(1) sample size (n),  

(2) zero-order/ Pearson correlation between the criterion and first predictor of 

interest (r12), 

(3) zero-order/ Pearson correlation between the criterion and second predictor of 

interest (r13), and  

(4) zero-order/ Pearson correlation between the first and second predictors of 

interest (r23). This information can be found in the Correlations table. 

As an example, for the standard multiple regression that examined eating 

difficulty (criterion) using ONLY THE TWO predictors of stress and sex: 

n = 40, r12 = .510, r13 = .382, r23 = .131 

This gives a Fisher-Z test result of: Z = 0.70, p = .242. 

 

IF YOUR MODEL HAS MORE THAN TWO PREDICTORS: 

If your regression model has MORE THAN TWO predictors, the values entered 

into the online calculator differ slightly and require extra SPSS analyses to gather 

relevant information! 

 

Specifically, if we have more than two model predictors, we replace r12 and r13 

with the partial correlation (pr) values for the two predictors we are comparing 

(found in the second last column of the Coefficients table at the relevant model 

step). 

 

However, we also need to calculate a separate partial correlation (pr) between the 

two predictors (which will replace r23), controlling for any other variables at that 

model step (including the criterion). This is achieved under the Analyze → 

Correlate → Partial analysis function in SPSS. E.g., for step 2 of the 

hierarchical multiple regression, move both Stress and Neuroticism (i.e., 

predictor 3 and predictor 4) into the Variables box, and Eating Difficulty (i.e., 

the criterion) as well as Age and Sex (i.e., predictor 1 and predictor 2, which were 

control variables entered at step 1 of the model) into the Controlling for box. 

Click Paste and run the syntax. 

 

Important note: Be sure that all pr values you enter into the online calculator are 

converted into POSITIVE numbers (otherwise you’ll get the wrong answer)! 

 

Example of APA 7th Format for Reporting Statistics of the 
Individual Predictors in a Standard Multiple Regression: 

 

Stress was a significant positive predictor, such that higher levels of stress were 

associated with greater eating difficulty, β = .47, t(37) = 3.53, p = .001, 95% CI 

[.20, .74]. Stress uniquely accounted for 22% of the variance in eating difficulty 

scores. However, a Fisher-Z test revealed stress did not differ significantly in 

strength from sex as a predictor of eating difficulty, Z = 0.70, p = .242. 
 

OR 
 

Stress significantly explained 22% of the unique variance in eating difficulty 

scores, whereby higher rated stress was associated with higher reported levels of 

eating difficulty, β = .47, t(37) = 3.53, p = .001, 95% CI [.20, .74]. In terms of 
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strength, although stress produced a higher unique contribution weight, a Fisher-Z 

test showed it was statistically equivalent to sex as a predictor of eating difficulty, 

Z = 0.70, p = .242. 

 

• Note that sr2 is reported in the text as a percentage i.e., 22%. 

• Beta values (β) should be reported rather than b. Beta is preferred as it is a 

standardised statistic and thus, enables you to compare different predictors in 

the same study in terms of their strength. Though note that the significance of 

these strength differences needs to be assessed using Fisher-Z tests. 

• The degrees of freedom (df) for the t-test are that for Residual, found in the 

ANOVA output table in SPSS. In contrast, the t-values are located in the 

Coefficients table. 

• Confidence intervals for the beta weights can be determined from the SPSS 

output for the b 95% confidence intervals. These calculations involve three 

extra steps (outlined earlier on page 42). 

• Given the confidence intervals are for β (rather than b), note that no 0 is placed 

in front of the decimal point. This is because these values cannot potentially 

exceed ±1. 

• When specifying confidence interval notation, the % only needs to be stated 

the first time they are employed within a paragraph or analysis set e.g., 95% 

CI [Lower, Upper]. After this, the percentage does not need to be repeated i.e., 

CI [Lower, Upper]. Also note that no italics are used for this notation. 

• Inclusion of Fisher-Z test results is required when speaking to whether or not 

an individual predictor is significantly stronger than another. This is needed to 

establish the order of predictor importance, based on the significant and 

relative magnitude order of their strength. Note the capital Z used for this 

notation, as well as the accompanying p-value. 

 

5. Lastly, state the amount of shared variability in the model (i.e., R2 – Σsr2) as a 

percentage in the text. There is no significance test associated with this. NB: 

shared variance cannot be a negative value. Therefore, if your calculations lead 

you to a small negative number, this is an artefact of the display and rounding of 

numbers in SPSS. Instead, report this value as less than 1%. 

 

As an example, for the SMR in Activity 5 Exercise 2 of the Tutorial Workbook, 

the overall regression model R2 was .361 (which rounds to 36%), while the sr2 

values for stress and sex were .215296 (22%) and .101124 (10%), respectively. 

The latter sr2 values are calculated by squaring the semi-partial or ‘part’ 

correlation for each predictor in the Coefficients table. When performing these 

calculations, use as many decimals as you have available to you to ensure 

maximal accuracy. As such, shared variance = .361 – .215296 – .101124 = 

.044580. Therefore, once rounded (i.e., .04), this shows that an additional 4% of 

variance in eating difficulty scores was explained by shared variability between 

stress and sex. 

 



PSYC3010: FORMAT EXPECTATIONS  47 

 

 

FORMAT TIPS FOR HIERARCHICAL AND  
MODERATED MULTIPLE REGRESSION 

 

*Note: A combination of the eating difficulty exercises from the hierarchical and 

moderated multiple regression tutorials have been used in this section. However, 

some values may have changed for illustrative purposes. 

 

1. If you have already provided the means, standard deviations, and zero-order 

correlations (with two-tailed tests of significance), then you would not repeat them 

at the start of a hierarchical or moderated multiple regression. However, if this has 

not been done, report these as part of your preliminary statistics in the next step 

(see step 2 from the section Format Tips for Standard Multiple Regression for 

how to report these). 

 

 

2. Describe the multiple regression analysis that was conducted, identifying the 

criterion and predictors. If this is the first time you have used the acronym/ 

abbreviation for your regression type in the text, it must be written out properly 

and introduced e.g., moderated multiple regression (MMR). Include the order of 

predictor entry into the model, and the rationale behind this order. 
 

 Remember that in moderated multiple regression we list the interaction as a 

predictor too. In moderated multiple regression, the rationale behind the order of 

predictor entry is to determine whether the interaction between the two predictors 

explains additional variance in the criterion OVER AND ABOVE that of the 

direct effects of the two predictors (where the criterion and predictors are named 

explicitly here). Also in moderated multiple regression, make sure that you note 

which variables were mean-centred and explain WHY this was done. Don’t forget 

to describe how the interaction term was calculated. In moderated multiple 

regression, the information covered in the previous two sentences would appear 

prior to listing the order of predictor entry into the model. 

 

 

3. Describe the proportion of variance in the criterion that was explained at step 1 

(i.e., R2
ch as a percentage in the text) as well as whether or not this was significant. 

Report the associated F change and significance level statistical notation at the 

end of the sentence i.e., Fch, df and p. 

 NB: It is important to report these change statistics for analysis techniques such as 

hierarchical multiple regression and moderated multiple regression. These 

analyses address the significance of the CHANGE in variance accounted for when 

blocks of predictors are entered into the model. 
 

Example of APA 7th Format for Reporting Statistics of the  
Model at Step 1 for Hierarchical Multiple Regression: 

 

At step 1, sex and age explained a significant 16% of the variance in eating 

difficulty scores, Fch(2, 37) = 3.39, p = .045. 
 

• Note that you should report R2 change as a percentage in the text (i.e., 16%). 

Generally, percentages reported in the text are presented as whole values. If 

the percentage is < 1%, it should be rounded and reported as either 1% (if it 

rounds up) or “less than 1% of the variance” (if it rounds down). You should 

not report 0% R2 change. 
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• Notice that the symbols for the statistics F and p are italicised. All statistics in 

English/ Latin letters should be. However, the subscript notation appears as 

standard text (i.e., not italicised). Likewise for any superscripts. 

• Also notice that the inferential statistics (F) only go to two decimal places. 

• In contrast, the p-value is reported to three decimals. 

• The degrees of freedom in a change model represent that for Regression and 

Residual of the change that has occurred at the relevant model step (found 

under the Change Statistics section of the Model Summary output table in 

SPSS i.e., df1 and df2, respectively). 

• Notice the spacing applied between elements of the statistical notation. I.e., it 

is not all run together, but rather is separated out for reader clarity. 

• Lastly, if confidence intervals are available for your R2 change value, these 

would be given at the end of the statistical notation following the p-value. 

 

 

4. Describe the unique contribution of each individual predictor at step 1, reporting 

their significance/ non-significance, direction of effect, βs, t-values, degrees of 

freedom, p-values and their associated 95% confidence intervals. These are 

reported just as you would in a standard multiple regression (as discussed in the 

previous section). Also provide the proportion of total variance in the criterion 

that was uniquely explained by each predictor (i.e., sr2 as a percentage in the text). 

If there was more than one predictor added to the model at this step, you would 

also give the amount of shared variance as a percentage in the text (i.e., step 1 R2
ch 

– Σsr2 for all predictors entered at step 1). Recall that shared variance cannot be a 

negative value. Therefore, if your calculations lead you to a small negative 

number, this is merely an artefact of the display and rounding of numbers in 

SPSS. Instead, report this value as less than 1%. 

 

As an example, for the HMR in Activity 5 Exercise 3 of the Tutorial Workbook, 

the step 1 model R2
ch was .155 (which rounds to 16%), while the sr2 values for sex 

and age were .145161 (15%) and .012321 (1%), respectively. The individual 

predictor sr2 values are calculated by squaring their associated semi-partial or 

‘part’ correlation in the Coefficients table at step 1. When conducting these 

calculations, be sure to use as many decimals as you have available to allow for 

maximal accuracy. In this case, the shared variance at step 1 = .155 – .145161 – 

.012321 = -.002482. This is, therefore, one of those rare cases where we obtain a 

small negative value due to SPSS issues of number displays and rounding. As 

such, this would be reported as showing that less than 1% of the variance in eating 

difficulty scores was explained by shared variability between sex and age at step 1 

of the model. 

 

 

5. Describe the increase in R2 that resulted from the inclusion of the additional 

predictor(s) at step 2. State whether or not this was a significant increment in the 

explanation of the criterion variance, reporting the F change, degrees of freedom 

and significance level statistics outlined previously. 

 

For moderated multiple regression: The interaction term is entered at step 2. 

Report the change statistics as you would for a hierarchical multiple regression. 

However, you also report whether or not this indicated there was a significant 

interaction, giving appropriate individual predictor statistical notation (i.e., β, t, df, 

p and 95% confidence intervals). 



PSYC3010: FORMAT EXPECTATIONS  49 

 

 

Example of APA 7th Format for Reporting Statistics of the 
Model at Step 2 for Hierarchical Multiple Regression and 

Moderated Multiple Regression: 
 

Hierarchical Multiple Regression: 

At step 2, stress and neuroticism significantly accounted for 35% of the eating 

difficulty score variance over and above that explained by sex and age at step 1, 

Fch(2, 35) = 12.46, p < .001. 

 

Moderated Multiple Regression: 

At step 2, the addition of the Stress x Self-Esteem interaction to the model 

significantly explained 8% of the variance in eating difficulty scores over and 

above the direct effects of stress and self-esteem, which indicated the presence of a 

significant interaction, Fch(1, 36) = 4.61, β = -.30, t(36) = -2.15, p = .039, CI [-.58, 

-.02]. 
 

• Again, the degrees of freedom (df) for the change model represent that for 

Regression and Residual of the change that has occurred at the relevant model 

step (found under the Change Statistics section of the Model Summary output 

table in SPSS i.e., df1 and df2, respectively). 

• In contrast, the degrees of freedom for the t-test are that for just Residual, and 

are located in the ANOVA output table for the relevant model step. 

• Note that the HMR p-value reported was converted to “< .001”, and was not 

reported as “= .000” even though SPSS gave the significance as the latter. You 

should never report a p-value as equal to either .000 or 1.000. Instead, you 

should report these as p < .001 and p > .999, respectively. 

• Calculation of the 95% confidence interval (CI) values for β involves the same 

three extra steps outlined in the SMR section on page 42. These calculations 

require information from the SPSS Coefficients output table. 

• When denoting the CI notation, the “95%” part of this is only stipulated the 

first time these are used within a paragraph or analysis set e.g., 95% CI 

[Lower, Upper]. Following this initial % specification, the percentage should 

not be repeated i.e., CI [Lower, Upper]. Further, note that no italics are 

employed for the 95% CI statistical notation. 

• Also be careful in the use (or non-use) of 0 before a decimal place. If a value 

can potentially exceed a threshold of ±1 (e.g., Fch and t), a 0 should be placed 

before the decimal point. However, if a value cannot potentially exceed ±1 

(e.g., β, 95% CI for β, and p), no 0 should appear before the decimal. 

• Once again, if you were working in a statistics program where confidence 

intervals were available for your R2 change value, these would be given at the 

end of the statistical notation following the p-value (for the top HMR 

example). 

 

 

6. Describe the individual contribution of each predictor entered at step 2. State the 

significance/ non-significance and direction of effect, providing the relevant 

statistical notation to accompany this (i.e., β, t, df, p and 95% CIs). Also give the 

proportion of variance in the criterion that was uniquely explained by each (i.e., 

sr2 as a percentage in the text). If there was more than one new predictor added to 

the model in this step/ block, you also need to provide the shared variance as a 

percentage in the text (i.e., step 2 R2
ch – Σsr2 for all new predictors entered at step 

2. This follows the same procedure outlined in point 4 above). 
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For moderated multiple regression: It makes no intuitive sense to describe the 

direction for the interactive effect (e.g., ‘positive’ or ‘negative’). Instead, as 

outlined before, simply state whether or not this indicated there was a significant 

interaction over and above the direct effects of the model, providing the associated 

β, t, df, p and 95% CI statistics at the end of the sentence. You should not provide 

the sr2 value for the interaction, as this will be the same as the R2 change value at 

step 2 and is therefore, redundant (see above example). 

 

7. Repeat steps 5 and 6 above for each additional step/ block that is involved in your 

HMR. 

 

8. Lastly, describe the overall model at the final step. Specifically, report the total 

proportion of variance in the criterion that was explained by all the predictors 

together (i.e., R2 at step 2 as a percentage in the text). Report whether or not this 

model was significant, with the appropriate corresponding F(df) and p-value 

statistics given at the end of the sentence. 

 

Example of APA 7th Format for Reporting Statistics for the  
Final Model of a Hierarchical Multiple Regression: 

 

At step 2, the overall model containing stress, neuroticism, age and sex explained a 

significant 51% of the variance in eating difficulty scores, F(4, 35) = 8.97, p < 

.001. 
 

• Note that you report R2 at the last model step as a percentage in the text (i.e., 

51%). Generally, percentages reported in the text are presented as whole 

values. If the percentage is < 1%, it should be rounded and reported as either 

1% (if it rounds up) or “less than 1% of the variance” (if it rounds down). You 

should not report 0% R2. 

• The degrees of freedom (df) this time represent that for Regression and 

Residual of the whole model (located in the ANOVA output table in SPSS at 

the last step). 

• Again, if confidence intervals are available for your R2 value, these would be 

given at the end of the statistical notation following the p-value. 

• Observe that inferential statistics such as F are reported to two decimal places, 

while p-values are taken to three decimals. 

• Also notice the spacing applied to the statistical notation. 

 

 

ADD THESE EXTRA TWO STEPS FOR MODERATED MULTIPLE 

REGRESSION (MMR): 

 

9. In MMR, you also need to report follow-up tests for a significant interaction. 

Display this interaction in an APA 7th format figure, and explain that the 

significant interaction was followed up by performing simple slopes analyses. 

In the figure, be sure to present separate lines for high and low levels of the 

moderator, and have the focal predictor variable on the x-axis. When referring 

your reader to the figure, make clear the key message(s) you want them to take 

away from the figure e.g., As seen in Figure 1, a significant interaction was 

present, whereby the positive effect of stress on reported eating difficulty level 

was eliminated at high self-esteem. 
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10. Explain that values one standard deviation above and below the mean were 

used for high and low levels, respectively, for each variable. 

• Then describe the effect of the key predictor (e.g., stress) on the criterion 

(e.g., eating difficulty) when the moderator was at a low level. Include the 

β, t and df for the slope, its significance level (p), and sr2 value as statistical 

notation. Describe the direction of effect and state whether or not this was 

significant. 

• Lastly, describe the effect of the key predictor (e.g., stress) on the criterion 

(e.g., eating difficulty) when the moderator was at a high level. Again, 

include the β, t and df for the slope, its significance level (p), and sr2 value 

as statistical notation. Also, again, describe the direction of effect and be 

sure to state whether or not this effect was significant. 

 

Example of APA 7th Format for Reporting Statistics of the Simple Slopes: 
 

For those with low self-esteem, stress had a significant positive influence, whereby 

higher stress levels were associated with greater reported eating difficulty, β = .65, 

t(36) = 4.31, p < .001, 95% CI [.34, .95], sr2 = .30. 
 

• Recognise that this time around, the sr2 value is included as statistical notation 

at the end, rather than reported as a percentage in the text. Do not do both, as 

this is redundant reporting (and therefore, goes against APA 7 format). 

• The degrees of freedom (df) for the t-test are that for Residual for the relevant 

model step. As such, this is found in the ANOVA output table in SPSS for step 

(model) 2. 

• Once again, the confidence intervals for your beta weights need to be 

calculated based on the information SPSS supplies for the 95% CIs for b 

(found in the Coefficients table from the simple slopes output). This procedure 

requires the same three extra steps outlined in the SMR section on page 42. 

• Note that when presenting the confidence interval statistical notation, the % is 

only required the first time they are stated within a paragraph or analysis set 

e.g., 95% CI [Lower, Upper]. After this, the percentage should not be 

stipulated again i.e., CI [Lower, Upper]. Also note that no italics are applied to 

this notation. 

 


